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Experiment 3: The Rovibrational Spectrum of HCl 
(was Experiment 4 in the syllabus, but the original Experiment 3 was canceled) 

 
Meet for lab on Thursday, April 10, 10:00 a.m., Olin-Rice 386 

 
Report due on Thursday, April 24 (note change from syllabus) 

 
Logistical Basics for Chemistry 312 Lab Work: 

• You are not required to keep a notebook. 
• You will follow the five Macalester Chemistry cardinal lab safety rules: 

1. Always wear goggles whenever you are inside a “wet” or “instrumental” lab. 
2. Always wear shoes that cover your feet. 
3. Never consume any food or drink in the lab. 
4. Always wash your hands whenever you leave the lab. 
5. Never work alone in a “wet” or “instrumental” lab, even when “just” using an 

instrument. 
• Each group will turn in one lab report, and all of the members of a group will share the 

same grade for each lab.   
 

Introduction 
 
In this laboratory, you will record the infrared spectra of two HCl isotopomers, H35Cl and H37Cl.  
Since the HCl is in its gaseous state, where it can freely rotate, this vibrational spectrum will also 
contain resolved rotational structure.  Such a spectrum is called a rovibrational spectrum.   You 
will assign quantum numbers to each transition in your spectra and fit an equation to the 
measured frequencies to determine values for the principal molecular constants.   

The energy levels of a rotating diatomic molecule in its ground and first excited vibrational states 
are given by the equations 

 v = 1:  F'(J) = 0
~υ + B'J(J + 1) – D'J 2(J + 1)2 [1] 

 v = 0:  F"(J) = B"J(J + 1) – D"J 2(J + 1)2 [2] 

The symbols F' and F" (the “rovibrational terms”) signify the energies of the upper and lower 
energy levels expressed in cm–1.  By convention, spectroscopists use a single prime for quantities 
relating to the upper state in a transition, and a double prime (or no prime) for quantities relating 
to the lower state.  The symbol B is the rotational constant, and D is the centrifugal distortion 
constant, which takes into account the effects of the molecule's vibration on the rotational energy 
levels.  Note that each vibrational state has its own rotational constant. 

The selection rules for the rovibrational spectrum of HCl are ∆v = ±1 and ∆J = ±1.  (Overtone 
bands, which are bands with ∆v = ±2, ±3, …, are allowed, but are much weaker than the 
fundamental band.  A general rule of thumb is that each successive higher overtone band is a 
factor of 10 weaker than the previous one.)  With these selection rules, the infrared spectrum of 
HCl near 2875 cm–1 consists of an R “branch” (or set of peaks) with ∆J = J' – J" = +1, and a P 
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branch with ∆J = –1.  You will observe absorption only from the ground vibrational level (v = 0) 
to the first excited vibrational level (v = 1), because the v = 0 level is the only one significantly 
populated at room temperature.  Such a band is called a cold band; hot bands originate from 
excited vibrational levels of the molecule.  You will observe both the H35Cl and H37Cl species in 
the 2875 cm–1 region because our FTIR spectrometer has just high enough resolution to resolve 
them.  The 35Cl:37Cl natural abundance ratio is 76:24, so the H35Cl will be noticeably stronger.  
Since the two Cl isotopomers act like distinct molecules (quantum mechanically speaking), you 
will fit their spectra separately. 

If we use Eqns. [1] and [2] to determine the energies of the generic transitions R(J – 1) and P(J), 
we obtain the general expressions 

 R(J – 1) = F'(J) – F"(J – 1) 

      = 0
~υ + (B' + B")J + (B' – B" – D' + D")J 2 + (–2D' – 2D")J 3 + (–D' + D")J 4 

 P(J) = F'(J – 1) – F"(J) 

      = 0
~υ + (–B' – B")J + (B' – B" – D' + D")J 2 + (2D' + 2D")J 3 + (–D' + D")J 4 

From the form of the above two equations, it is possible to fit an identical equation to both 
branches, namely  

   υ~  = 0
~υ  + (B' + B")m + (B' – B" – D' + D")m2 + (–2D' – 2D")m3 + (–D' + D")m4 [3] 

where m is an integer called the line number that takes the values 1, 2, 3, ... for the R(J) branch 
(that is, m = J + 1) and the values –1, –2, –3, ... for the P(J) branch (that is, m = –J). 

This is the strategy you should employ.  Fit Eqn. [3] to your experimental measurements of the 
transition frequencies to derive values for the five constants 0

~υ , B', B", D', and D".  Fit each of 
the two isotopomers separately using Excel.  Record a minimum of six significant figures for 
your fitted constants.  In Excel, this means that you should select the fitted quartic (or fourth 
order) equation in x, then choose Selected Data Labels… under the Format menu, and change the 
Number formatting to Scientific notation with at least six significant figures.  Using a little 
algebra, you will be able to find values for the physically significant constants in Eqn. [3] from 
the fitted values of the quartic polynomial coefficients.  Prof. Varberg and I do not recommend 
doing this by hand with a calculator, which is a boring and error-prone process.  Type the values 
of the polynomial coefficients (carefully!) into separate cells and then let Excel carry out the 
necessary calculations. 

In doing this, you will have determined two values for Bv for each isotopomer of HCl, namely B0 
and B1 (represented by B" and B' in the equation above), the rotational constants in v = 0 and 1 
respectively.  From these, you can determine the bond lengths in these two vibrational states 
using the following formula 
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where μ is the reduced mass and Rv is the bond length in the vibrational state v.  For each 
isotopomer, you can also determine a value for Be, the equilibrium value of the rotational 
constant at the minimum of the potential well, using the expression 

 )v( 2
1+−= eeBB αv  [5] 

where αe is a constant for each isotopomer of HCl.  From Be, you can determine values for Re, 
the equilibrium bond length, for each isotopomer.  These values should be the same, to within 
experimental error (assuming the Born-Oppenheimer approximation holds). 

For each isotopomer, the rotational constant, the centrifugal distortion constant, and the 
vibrational frequency are related by a formula derived by Kratzer.  The formula holds exactly 
only for a molecule obeying a Morse potential energy curve, but it should work reasonably for a 
real diatomic molecule.  Note that D0 in this expression is the centrifugal distortion constant for 
the v = 0 level, not the dissociation energy. 
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The force constant k of the HCl bond can be determined from the expression 

 ν0 =
1

2π
k
μ , [7] 

where the vibrational frequency ν0 is given in Hz. 

Experimental Procedure 
 
Rob Rossi, the James Brown (i.e. the hardest working man) in Olin-Rice, will have filled a gas 
cell with HCl and demonstrated the following instructions for operating the Chemistry 
Department’s Nicolet Fourier 550 Transform Infrared Spectrometer (in Olin-Rice 386): 

Collecting Your Data 

1. Turn on the monitor and printer.  Then launch the program Omnic E.S.P. 5.1. 

2. Choose Experiment Setup… from the Collect menu.  Set the number of scans you want 
(typically 16) and the resolution (for HCl, use the highest resolution available: 0.5 cm–1).  
Select Collect background before every sample.  Click OK.  Set the optimum aperture 
automatically, if it asks you to do so. 
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3. Unlatch and open the central door on the spectrometer and make sure no sample is mounted.  
Close the door.  Then choose Collect Sample… from the Collect menu.  Leave the default 
spectrum title unchanged and click OK.  Click OK again to acquire the background scan.  
(You can monitor how many scans have been collected with the status bar at the bottom left 
of your window.)  You should see peaks due to absorption by CO2 and H2O. 

4. Next, open the door, mount the sample cell filled with HCl in the beam path, close the door, 
and click OK to collect the sample spectrum.  (The cell is stored in a plastic bucket next to 
the spectrometer.)  Click on Yes to add the spectrum to the window.  The active spectrum 
will appear in red.  Each peak should be a doublet, with the more intense member of the 
doublet being due to the more abundant H-35Cl isotopomer. 

5. (You can probably skip this step.)  For weak spectra it is useful to perform a baseline 
correction.  Choose Absorbance from the Process menu, followed by Automatic Baseline 
Correction from the Process menu.  Click and drag the right boundary marker in the View 
Finder (that’s the skinny spectral window at the bottom of the screen) to eliminate the strong 
noise peaks at low frequency.  The autoscale the spectrum by choosing Full Scale from the 
View menu (or setting it on Automatic Full Scale).  Your window will now contain two 
spectra:  the original (inactive) spectrum in blue, and the corrected (active) spectrum in red.  
Select the blue spectrum by clicking on it or choosing its title in the title bar.  Then delete 
this spectrum by choosing Clear from the Edit menu.  Doing so will prevent confusion. 

Labeling Your Peaks 

6. You are now ready to characterize your spectrum.  Enlarge the window to full screen.  Click 
and drag the blue vertical boundary markers in the View Finder at the bottom of the window 
to select a wavenumber range of interest.  Be sure not to exclude carelessly any weak lines 
at the edges of your spectrum. 

7. Choose Find Peaks… from the Analyze menu.  Have some fun with the sensitivity setting 
(the scroll bar on the left of the window) and the threshold setting (click anywhere on the 
spectrum to move the threshold up and down) until you are certain that you have found all 
of the real peaks and none of the noise (the unattainable goal of any spectroscopist!).  If you 
aren’t happy with the locations of the boundary markers you chose, click on the Window 
menu and choose Window 1—this is still displaying the original version of your spectrum.  
Then repeat Step 6. 

8. When you are satisfied that all of the relevant peaks have been labeled, click the Print button 
(in the upper left of the window) to print a copy of the spectrum and the peak list.   

9. When you are done, quit the program by selecting Exit... from the File menu.  (You will 
likely need to click Yes twice.)   

10. Turn off the printer and the monitor.  Put the sample cell back in the plastic bucket. 
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Data Analysis 

1. Label the branch assignments for the H35Cl isotopomer on the spectrum you have printed off. 

2. Assign the transitions by branch, J, and isotopomer.  Note that our FTIR spectrometer plots 
lower energy (wave number) to the right, which is the standard Herzberg spectroscopic 
convention. 

3. Fit the transition wavenumbers (in cm–1) to Eqn. [3].  Report values for the five directly 
determinable molecular constants of each isotopomer.  Include a copy of your Excel 
spreadsheet and the graph of υ~ vs. m for each isotopomer in your lab report.  Please organize 
your results for the different isotopomers in a combined table in one spreadsheet page. 

4. Determine the bond lengths in Å (1 Å = 10–10 m) in these vibrational states using Eqn. [4].  
Does the bond length shorten or lengthen upon vibrational excitation?  Explain this behavior. 

 Note: To do this calculation properly, you must use precise 
atomic masses for the various isotopes good to at least six digits 
as well as similarly precise values for the fundamental constants.  
Your textbook lists isotopic masses in the Appendix, but 
unfortunately the values given are not all correct.  Please consult 
the table to the right for the values you need.  Furthermore, the 
value given for the speed of light inside the front cover of your 
textbook has a typographical error in the seventh digit—the 
correct value is c = 2.99792458 × 108 m s–1. 

5. Calculate equilibrium values for the rotational constant Be, the constant αe, and the bond 
length Re from Eqns. [4] and [5].  Compare and comment on the values for the equilibrium 
bond lengths of the two isotopomers.  Also compare your results for H35Cl with the 
“literature” values given by Atkins/de Paula (Table 13.2 in the Data Section). 

6. Test the Kratzer relation, Eqn. [6], for the two isotopomers.  Comment on your results. 

7. Calculate the force constant in N/m for the two isotopomers from Eqn. [7], again comparing 
your results with those given in Atkins/de Paula, Data Section Table 13.2.  Can you offer a 
possible explanation for any disagreement between your value and the literature value?  
Would you expect the force constants of the isotopomers to be equal to each other? 

Final Product 
 
You will write a paper with the same sections (Title, Your Names, Abstract, Introduction, 
Procedure, Results and Discussion, Conclusions, References, Appendix) as your Chemistry 311 
written lab reports.  However, note that your Procedure should be extremely short (two to three 
sentences will suffice).  The focus of your paper should be addressing the questions posed in the 
Data Analysis section of the instructions. 
 
 

Isotope Mass (in u) 
1H 1.007825 
2H 2.014102 

35Cl 34.968853 
37Cl 36.965903 


